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Paper Set 1 · 11 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
The ratio of the present ages of A and B is 7 : 5. After 6 years from
now, the ratio of their ages will become 9 : 7. Find the present age of
A.

A.  C. 14 years

B.  B. 21 years

C.  A. 28 years

D.  D. 35 years

✓

Q2 Quant
A man in his journey, covers the first 300 km at 90 km/hr and the
next 80 km at 120 km/hr. Find the average speed of his 380 km
journey.

A.  A. 110 km/hr

B.  D. 95 km/hr

C.  C. 100 km/hr

D.  B. 90 km/hr

✓

Q3 Quant
ଜଣେ ଦୋକାନୀ ସମାନ କ୍ର ୟ ମୂ ଲ୍ୟର ଦୁ ଇଟି  ସାମଗ୍ରୀ କୁ  ସମାନ ବି କ୍ର ୟ ମୂ ଲ୍ୟରେ ବି କ୍ରି
କଲେ । ଗୋଟି ଏ ସାମଗ୍ରୀ  ଉପରେ ସେ 15% ଲାଭ ପାଉଥି ବା ବେଳେ ଅନ୍ୟ ସାମଗ୍ରୀ ଟି
ଉପରେ 15% କ୍ଷତି  ସହନ୍ତି  । ସମଗ୍ର  କାରବାରରେ ଲାଭ କି ମ୍ବା କ୍ଷତି  କେତେ ଅଟେ?

A.  D. 1.5% କ୍ଷତି

B.  B. 1.5% ଲାଭ

C.  C. କୌଣସି  ଲାଭ କି ମ୍ବା କ୍ଷତି  ନାହିଁ

D.  A. 3% ଲାଭ

✓

Q4 Quant
Bus A covers a certain distance in 10 hours at a speed of 80 km/hr.
Bus B covers 130 km more than Bus A in the same time. Find the
average speed of Bus B.

A.  B. 90 km/hr

B.  D. 91 km/hr

C.  A. 92 km/hr

D.  C. 93 km/hr

✓

Q5 Quant
If 'x' be the product of the prime numbers between 50 and 60, and
'y' be the sum of the prime numbers between 30 and 40, then find
the value of x-2y .

A.  C. 2991

B.  B. 3291

C.  D. 1286

D.  A. 2408

✓

Q6 Quant

The roots of the equation 2x2 − 6x + 37 = 0 are:

A.  C. real and equal

B.  B. rational

C.  D. irrational

D.  A. imaginary

✓

Q7 Quant
ପାଇପ୍  A ଏକ ଟାଙ୍କି କୁ  6 ଘଣ୍ଟାରେ ଏବଂ ପାଇପ୍  B ସମାନ ଟାଙ୍କି କୁ  6 ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ
କରି ପାରି ବ । ଯଦି  ଉଭୟ ପାଇପ ଏକାସାଙ୍ଗରେ ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି କୁ  ପୂ ର୍ଣ୍ଣ  କରି ବା
ପାଇଁ  ମୋଟ କେତେ ସମୟ ଆବଶ୍ୟକ ହେବ ?

A.  C. 2 ଘଣ୍ଟା

B.  A. 3 ଘଣ୍ଟା

C.  D. 4 ଘଣ୍ଟା

D.  B. 5 ଘଣ୍ଟା

✓

Q8 Quant
ଏକ ଡାଟାସେଟର ମୂ ଲ୍ୟଗୁ ଡ଼ି କ 2, 3, 3, 3, 4, 5, 5, 5, 6, 6, 6, 7, 9 ଏବଂ 11 ଅଟେ ।
ଡାଟାସେଟର ଗରି ଷ୍ଠକ (ଗୁ ଡ଼ି କ) ନି ର୍ଣ୍ଣ ୟ କର ।

A.  C. 3,5

B.  D. 6

C.  B. 3,5,6

D.  A. 5,6
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✓

Q9 Quant
ଏକ ସରଳ ବୃ ତ୍ତଭୂ ମି କ କୋନ ଏବଂ ଏକ ସରଳ ବୃ ତ୍ତଭୂ ମି କ ସି ଲି ଣ୍ଡରର ଭୂ ମି  ଓ ଉଚ୍ଚତା
ସମାନ ଅଟେ । ଯଦି  ସେମାନଙ୍କର ଭୂ ମି ର ବ୍ୟାସାର୍ଦ୍ଧ  ଏବଂ ଉଚ୍ଚତାର ଅନୁ ପାତ 4 : 3 ହୁ ଏ,
ତେବେ ସି ଲି ଣ୍ଡରର ସମଗ୍ର  ପୃ ଷ୍ଠତଳର କ୍ଷେତ୍ର ଫଳ ଏବଂ କୋନର ସମଗ୍ର  ପୃ ଷ୍ଠତଳର
କ୍ଷେତ୍ର ଫଳର ଅନୁ ପାତ କେତେ?

A.  D. 14 : 9

B.  C. 19 : 7

C.  A. 13 : 14

D.  B. 11 : 8

✓

Q10 Quant
Pawan and Dinesh started a business by investing amounts of
₹2,600 and ₹1,300, respectively. If Pawan's share in the profit earned
by them is ₹640, what is the total profit (in ₹) earned by them
together?

A.  C. 960

B.  D. 910

C.  B. 1,116

D.  A. 926

✓

Q11 Quant
The average of 6.5, 10.7, 20.2 and a is 19. The value of a is:

A.  A. 38.6

B.  C. 37.6

C.  D. 39.6

D.  B. 40.6

✓

Q12 Quant
35 ର 25% ଅପେକ୍ଷା 65 ର 30% କେତେ ଅଧି କ ଅଟେ?

A.  D. 10.75

B.  A. 5.75

C.  C. 7.75

D.  B. 12.75

✓

Q13 Quant
A and B working together can do a piece of work in 5 days. B alone
can do the same work in 20 days. How long (in days) will A alone
take to do thrice the work?2556

A.  A. 20

B.  C. 40

C.  B. 60

D.  D. 80

✓

Q14 Quant

₹7,544 is divided among X, Y, and Z such that if ₹14, ₹25, and ₹85
are deducted from their respective shares, the remaining amounts
are in the ratio 20:4:11. Find X’s share after the deduction.

A.  A. ₹4240

B.  B. ₹4090

C.  D. ₹4390

D.  C. ₹4140

✓

Q15 Quant
Krish has ₹1281 with him. He divided it amongst his sons Veer and
Nitin and asked them to invest it at 10% rate of interest
compounded annually. It was seen that Veer and Nitin got same
amount after 18 and 19 years, respectively. How much money (in ₹)
did Krish give to Nitin?10090

A.  610

B.  671

C.  460

D.  771

✓

Q16 Quant
O କେନ୍ଦ୍ରବି ଶି ଷ୍ଟ ଏକ ବୃ ତ୍ତରେ AB ଓ BC ଦୁ ଇଟି  ଜ୍ୟା ଅଙ୍କନ କରାଯାଇଛି  । A ଓ C
ବି ନ୍ଦୁ ଦ୍ଵୟକୁ  କେନ୍ଦ୍ର O ସହି ତ ଯୋଗ କରାଯାଇଛି  । ଯଦି  ∠OAB ଏବଂ ∠OCB ଯଥାକ୍ର ମେ
36° ଏବଂ 50° ହୁ ଏ, ତେବେ ପ୍ର ବୃ ଦ୍ଧ ∠AOC ର ଡି ଗ୍ରୀ  ପରି ମାଣ କେତେ?

A.  B. 207 °

B.  D. 188 °

C.  C. 200 °

D.  A. 220 °

✓

Q17 Quant
Ramesh sells a table to Mukesh at a profit of 25%, and then Mukesh
sells it to Jaybind at a profit of 60%. If Jaybind pays ₹1,286 for the
table, its cost price (in ₹) for Ramesh is:

A.  B. 643

B.  C. 645

C.  A. 640

D.  D. 642
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✓

Q18 Quant

If , then on simplification, the value of Y is

A.  

B.  

C.  

D.  

✓

Q19 Quant

1785

A.  

B.  

C.  

D.  

✓

Q20 Quant

A.  A. 41.75

B.  B. 38.75

C.  C. 35.75

D.  D. 39.75
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GA

✓

Q21 GA
1833 ମସି ହା ଚାର୍ଟ ର ଆଇନ ଅନୁ ଯାୟୀ ଭାରତର ପ୍ର ଥମ ଗଭର୍ଣ୍ଣ ର-ଜେନେରାଲ କି ଏ
ଥି ଲେ?

A.  D. ଲର୍ଡ  ୱି ଲି ୟମ ବେଣ୍ଟି କ

B.  A. ଲର୍ଡ  ଡେଲହାଉସି  

C.  B. ଲର୍ଡ  କ୍ୟାନିଂ

D.  C. ଲର୍ଡ  କର୍ଣ୍ଣ ୱାଲି ସ

✓

Q22 GA
ଖେଲୋ ଇଣ୍ଡି ଆ ୟୁ ଥ ଗେମ୍ସ  2025ର ଅଫି ସି ଆଲ ମାସ୍କଟର ନାମ କ’ଣ ଅଟେ?

A.  C. ଉଜ୍ଜ୍ୱଲା

B.  A. ଶେରୁ

C.  D. ଚି ତା

D.  B. ଗଜସିଂ ହ

✓

Q23 GA
ନି ମ୍ନ ଲି ଖି ତ ବ୍ୟକ୍ତି ମାନଙ୍କ ମଧ୍ୟରୁ  କାହାକୁ  2025 ମସି ହା ଜୁ ଲାଇ ମାସରେ ଭାରତୀୟ
ପ୍ର ତି ଭୂ ତି  ଓ ବି ନି ମୟ ବୋର୍ଡ  (SEBI) ର କାର୍ଯ୍ୟ କାରୀ ନି ର୍ଦ୍ଦେ ଶକ (Executive Director)
ଭାବେ ନି ଯୁ କ୍ତ କରାଯାଇଛି ?

A.  B. ସୁ ନୀଲ ଜୟବନ୍ତ କଦମ (Sunil Jayawant Kadam)

B.  A. ଅନନ୍ତ ନାରାୟଣ ଜି  (Ananth Narayan G)

C.  D. ଅମରଜି ତ ସିଂ  (Amarjeet Singh)

D.  C. ଏମ. ରାଜେଶ୍ୱର ରାଓ (M. Rajeshwar Rao)

✓

Q24 GA
ବହୁ ଳ ଅପଚୟ ପ୍ର କ୍ରି  ୟା (mass wasting processes) ରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି
ମୁ ଖ୍ୟତଃ ଗୋଟି ଏ ସ୍ଥାନରୁ  ଅନ୍ୟ ସ୍ଥାନକୁ  ସାମଗ୍ରୀ  ପରି ବହନରେ ସାହାଯ୍ୟ କରେ?

A.  D. ଜଲବାହୀ କାର୍ଯ୍ୟ

B.  C. ମାଧ୍ୟାକର୍ଷ ଣ

C.  A. ହି ମବାହ ଉତ୍ପାଟନ (Glacier plucking)

D.  B. ତରଙ୍ଗ କାର୍ଯ୍ୟ  (Wave action)

✓

Q25 GA
2025 ମସି ହା ସେପ୍ଟେମ୍ବର ମାସରେ ଶକ୍ତି  ସଂରକ୍ଷଣ ଭି ତ୍ତି ଭୂ ମି କୁ  ତ୍ୱରାନ୍ୱି  ତ କରି ବା ଏବଂ
ରାଜ୍ୟର ବି ଦ୍ୟୁ ତ ଗ୍ରୀ ଡରେ ନବୀକରଣ ଯୋଗ୍ୟ ଶକ୍ତି ର ସୁ ଗମ ସଂଯୋଜନାକୁ  ସୁ ନି ଶ୍ଚି ତ
କରି ବା ଉଦ୍ଦେଶ୍ୟରେ ଓଡ଼ି ଶା ସରକାର ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ନୀତି  ପ୍ର ଣୟନ କରି ଥି ଲେ?

A.  A. ଓଡ଼ି ଶା ସୋଲାର ଇଣ୍ଟି ଗ୍ରେ ସନ ଆଣ୍ଡ ଷ୍ଟୋରେଜ ପଲି ସି , 2025 

B.  C. ଓଡି ଶା ପମ୍ପଡ ଷ୍ଟୋରେଜ ପ୍ରୋ ଜେକ୍ଟ ପଲି ସି , 2025

C.  D. ଓଡି ଶା ଗ୍ରୀ ନ ଏନର୍ଜି କରି ଡର ପଲି ସି , 2025

D.  B. ଓଡ଼ି ଶା ଗ୍ରୀ ଡ-ସ୍କେଲ ବ୍ୟାଟେରୀ ଷ୍ଟୋରେଜ ପଲି ସି , 2025

✓

Q26 GA
ମୁ ଖ୍ୟ ଅକ୍ଷ ଏବଂ ଏହା ସହ ସମାନ୍ତର ଆପତି ତ ଆଲୋକ ରଶ୍ମି   ମଧ୍ୟରେ କୋଣ _________
ଅଟେ ।

A.  B. 0°

B.  D. 45°

C.  A. 90°

D.  C. ବକ୍ର ତା ଉପରେ ନି ର୍ଭ ର କରେ 

✓

Q27 GA
କ୍ଲୋ ରି ନ ସହ ମି ଥେନର ଏକ ପ୍ର ତି ସ୍ଥାପନ ପ୍ର ତି କ୍ରି  ୟା କରି ବା ପାଇଁ  କେଉଁ  ଅବସ୍ଥା ଆବଶ୍ୟକ
ଅଟେ?

A.  D. ଅମ୍ଳ ର ଉପସ୍ଥି ତି

B.  A. କ୍ଷାରର ଉପସ୍ଥି ତି  

C.  B. ସୂ ର୍ଯ୍ୟ କି ରଣର ଉପସ୍ଥି ତି  

D.  C. ଜଳର ଉପସ୍ଥି ତି

✓

Q28 GA
ନି ମ୍ନ ଲି ଖି ତ ବ୍ୟକ୍ତି ମାନଙ୍କ ମଧ୍ୟରୁ  'ହ୍ଵାଏ ଦ କନଷ୍ଟି ଚ୍ୟୁ ସନ ମ୍ୟାଟର୍ସ ' (Why the
Constitution Matters) ପୁ ସ୍ତକର ଲେଖକ କି ଏ?

A.  D. ଜଷ୍ଟି ସ ରଞ୍ଜନ ଗୋଗୋଇ

B.  B. ଜଷ୍ଟି ସ U.U. ଲଳି ତ

C.  C. ପୂ ର୍ବ ତନ CJI D.Y. ଚନ୍ଦ୍ରଚୂ ଡ

D.  A. ପୂ ର୍ବ ତନ CJI P.N. ଭାଗବତ

✓

Q29 GA
ଜୀବନ ରକ୍ଷା ପାଇଁ  ରକ୍ଷଣାବେକ୍ଷଣ ପ୍ର କ୍ରି  ୟା ଆବଶ୍ୟକ, କାରଣ ______________ ।

A.  D. ଏଗୁ ଡ଼ି କ ବାର୍ଦ୍ଧ କ୍ୟ ପ୍ର କ୍ରି  ୟାରେ ସାହାଯ୍ୟ କରନ୍ତି

B.  C. ସେଗୁ ଡ଼ି କ କୋଷୀୟ କ୍ଷତି କୁ  ରୋକି ଥାନ୍ତି  ଏବଂ ବଞ୍ଚି  ରହି ବା ସୁ ନି ଶ୍ଚି ତ କରନ୍ତି

C.  A. ସେମାନେ ଅସ୍ଥାୟୀ ଭାବରେ ଶ୍ୱସନ ବନ୍ଦ କରନ୍ତି

D.  B. ସେଗୁ ଡ଼ି କ ସ୍ୱଭୋଜୀମାନଙ୍କୁ  ଆଲୋକଶ୍ଳେଷଣ ପ୍ର କ୍ରି  ୟା ସମ୍ପାଦନ କରି ବାରେ
ସାହାଯ୍ୟ କରନ୍ତି

✓

Q30 GA
ସେପ୍ଟେମ୍ବର 2025 ରେ ଭାରତ କେଉଁ  ଦେଶ ସହି ତ ଦ୍ୱି ପାକ୍ଷି କ ନି ବେଶ ଚୁ କ୍ତି  (BIT) ସ୍ୱାକ୍ଷର
କରି ଥି ଲା?

A.  C. ଅଷ୍ଟ୍ରେଲି ଆ

B.  B. ଇସ୍ରା ଏଲ

C.  A. କାନାଡା

D.  D. ଯ଼ୁ ନାଇଟେଡ ଆରବ ଏମି ରେଟେସ
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✓

Q31 GA
ଓଡ଼ି ଶା ପୋଲି ସର ଉତ୍ତର ପରି ସୀମା ଅଧୀନରେ ଥି ବା ପାଞ୍ଚଟି  ଜି ଲ୍ଲାରେ 2025 ମସି ହା ଅଗଷ୍ଟ
25 ରୁ  ସେପ୍ଟେମ୍ବର 1 ମଧ୍ୟରେ “ଅପରେସନ ଗଜ” (Operation Gaja) କାର୍ଯ୍ୟ କାରୀ
ହୋଇଥି ଲା । ତେବେ, ନି ମ୍ନୋ କ୍ତ ମଧ୍ୟରୁ  କେଉଁ  ଜି ଲ୍ଲା ଏହି  ପାଞ୍ଚଟି  ଜି ଲ୍ଲା ମଧ୍ୟରେ ଅନ୍ତର୍ଭୁ କ୍ତ ନ
ଥି ଲା?

A.  A. ସମ୍ବଲପୁ ର

B.  C. ବଲାଙ୍ଗୀର

C.  D. ଝାରସୁ ଗୁ ଡା

D.  B. ଖୋର୍ଦ୍ଧା

✓

Q32 GA
ବି ଭି ନ୍ନ ସମୟ ଅବଧି  (ପି ଢି ) ମଧ୍ୟରେ ନ୍ୟାୟ ଏବଂ ସମତା (fairness) ସହି ତ ଜଡି ତ
ଧାରଣୀୟ ବି କାଶ (sustainable development) ର ମୁ ଖ୍ୟ ନୀତି କୁ  କ'ଣ କୁ ହାଯାଏ ?

A.  B. ଆନ୍ତଃନି ର୍ଭ ରଶୀଳତା (Interdependence)

B.  C. ଆନ୍ତଃ-ପି ଢ଼ି ଗତ ସମତା (Inter-generational equity)

C.  A. ଗ୍ର ହ ସମ୍ବନ୍ଧୀୟ ସୀମା (Planetary boundaries)

D.  D. ସମ୍ବଳ ଆବଣ୍ଟନ (Resource allocation)

✓

Q33 GA
ଭାରତର ସ୍ଵାଧୀନତା ପୂ ର୍ବ ରୁ  ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବର୍ଷ  ଓଡ଼ି ଶାକୁ  ଏକ ସ୍ଵତନ୍ତ୍ର ପ୍ର ଦେଶ ଭାବରେ
ଗଠନ କରାଯାଇଥି ଲା?

A.  D. 1912

B.  A. 1922

C.  B. 1936

D.  C. 1941

✓

Q34 GA
ଯଜୁ ର୍ବେ ଦ ସହି ତ କେଉଁ  ବ୍ରା ହ୍ମଣ ଗ୍ର ନ୍ଥଗୁ ଡ଼ି କ ଜଡି ତ?

A.  D. ତୈ ତ୍ତି ରୀୟ ଏବଂ ଶତପଥ (Taittiriya and Shatapatha)

B.  A. ପଞ୍ଚଭୀମଶା ଏବଂ ଜୈ ମି ନୀୟ (Panchavimsha and Jaiminiya)

C.  C. ଗୋପଥ ଏବଂ ତୈ ତ୍ତି ରି ଆ (Gopatha and Taittiriya)

D.  B. ଐତରେୟ ଏବଂ କୌଷି ତାକୀ (Aitareya and Kaushitaki)

✓

Q35 GA
କୃ ଷି  ଉତ୍ପାଦନର କେଉଁ  ଗଠନଗତ ବୈ ଶି ଷ୍ଟ୍ୟ ଯୋଗୁଁ  ମୁ ଖ୍ୟତଃ ଗ୍ରା ମୀଣ ଋଣର ଆବଶ୍ୟକତା
ଦେଖାଦି ଏ?

A.  B. ଉଚ୍ଚ ଶ୍ର ମ ଉତ୍ପାଦକତା (High labour productivity)

B.  D. ସ୍ୱଳ୍ପ ଉତ୍ପାଦନ ଚକ୍ର

C.  A. ଦୀର୍ଘ  ଗର୍ଭ କାଳ (Long gestation period)

D.  C. ସୁ ନି ଶ୍ଚି ତ ଫସଲ ଆୟ

✓

Q36 GA
ଭାରତର ନି ମ୍ନ ଲି ଖି ତ ଶାସ୍ତ୍ରୀୟ ନୃ ତ୍ୟ ମଧ୍ୟରୁ  କେଉଁ ଟି  କେରଳରୁ  ଉତ୍ପନ୍ନ ହୋଇଥି ଲା ଏବଂ
ମହାକାବ୍ୟ ଉପରେ ଆଧାରି ତ ଏହାର ବି ସ୍ତୃତ ପୋଷାକ, ମୁ ହଁ  ଅଭି ବ୍ୟକ୍ତି  ଏବଂ କାହାଣୀ ପାଇଁ
ଜଣାଶୁ ଣା ଅଟେ?

A.  B. ଭରତନାଟ୍ୟମ

B.  A. କଥକ

C.  D. କଥକଲି

D.  C. ଓଡ଼ି ଶୀ

✓

Q37 GA
ଭାରତରେ ମୌସୁ ମୀ ବାୟୁ ର ଆକସ୍ମି କ ଆଗମନ ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ
ବାୟୁ ମଣ୍ଡଳୀୟ ପରି ସ୍ଥି ତି କୁ  ଦାୟୀ କରାଯାଇଥାଏ?

A.  B. ପଶ୍ଚି ମା ଝଡ଼ (Western Distrubances)

B.  D. ପୂ ର୍ବା ଭି ମୁ ଖୀ ଜେଟ ପ୍ର ବାହ (Easterly jet stream)

C.  C. ମ୍ୟାଡେନ-ଜୁ ଲି ଆନ ଦୋଳନ (Madden-Julian Soscillation)

D.  A. ଲା ନି ନା ପ୍ର କ୍ରି  ୟା (La Nina phenomenon)

✓

Q38 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଆକ୍ଟ ଭାରତୀୟ ପ୍ର ଦେଶଗୁ ଡି କରେ 'ଦ୍ଵେତ ଶାସନ' ବ୍ୟବସ୍ଥା (Dyarchy)
ପ୍ର ଚଳନ କରି ଥି ଲା?

A.  B. ଗଭର୍ଣ୍ଣ ମେଣ୍ଟ ଅଫ ଇଣ୍ଡି ଆ ଆକ୍ଟ, 1935

B.  D. ଗଭର୍ଣ୍ଣ ମେଣ୍ଟ ଅଫ ଇଣ୍ଡି ଆ ଆକ୍ଟ 1919

C.  A. ଇଣ୍ଡି ଆନ କାଉନସି ଲ ଆକ୍ଟ 1861

D.  C. ଇଣ୍ଡି ଆନ ଇଣ୍ଡି ପେଣ୍ଡେନ୍ସ  ଆକ୍ଟ 1947

✓

Q39 GA
ଓଡ଼ି ଶାର ଜଳବାୟୁ  ମୁ ଖ୍ୟତଃ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବର୍ଗୀ ୟ ଅଟେ?

A.  B. କ୍ରା ନ୍ତୀୟ ମରୁ ଭୂ ମି  (tropical desert)

B.  D. କ୍ରା ନ୍ତୀୟ ମୌସୁ ମୀ (tropical monsoon)

C.  C. ନାତି ଶୀତୋଷ୍ଣ ସାମୁ ଦ୍ରି  କ (temperate oceanic)

D.  A. ସବଆର୍କ ଟି କ (subarctic)

✓

Q40 GA
ନର୍ମ ଦା ନଦୀ କେଉଁ  ସ୍ଥାନରୁ  ଉତ୍ପତ୍ତି  ହୋଇଛି ?

A.  C. ସତପୁ ରା

B.  D. ଅମରକଣ୍ଟକ

C.  A. ବ୍ର ହ୍ମଗି ରି

D.  B. ପଶ୍ଚି ମ ଘାଟ
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English

✓

Q41 English
Select the option that can be used as a one-word substitute for the given group of words.

One who cannot die

A.  B. Mortal

B.  D. Immortal

C.  C. Biodegradable

D.  A. Perishable

✓

Q42 English
Select the option that expresses the given sentence in passive voice.

Tina paints the walls every year.

A.  B. The walls were painted by Tina every year.

B.  C. The walls have been painted by Tina every year.

C.  A. The walls are painted by Tina every year.

D.  D. The walls is painted by Tina every year.

✓

Q43 English
Select the option that can be used as a one-word substitute for the given group of words.

A place where dead bodies are kept before their burial or cremation

A.  A. Cemetery

B.  B. Morgue

C.  D. Mausoleum

D.  C. Vault

✓

Q44 English
In the following question, a statement has been given in brackets. You are required to replace the statement with the correct idiom given in the
options.
When the final results were announced, Tanvi suddenly became extremely happy. She (became extremely cheerful and excited) after seeing her
marks.

A.  C. Hit the sack

B.  D. Turned a blind eye

C.  B. Lost her temper

D.  A. Jumped for joy
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✓

Q45 English
Select the most appropriate ANTONYM of the highlighted word in the given sentence.

The process was tedious and took several hours to complete.

A.  B. gigantic

B.  D. boring

C.  C. exciting

D.  A. deceptive

✓

Q46 English
Identify the correct substitute for the incorrect word-segment in the given proverb.

The road to heaven is paved with bad intentions.

A.  D. The road to home is paved with good gravel.

B.  A. The road to happiness is paved with strong intentions.

C.  C. The road to hell is paved with good intentions.

D.  B. The road to hell is paved with good obedience.

✓

Q47 English
From the options given below, choose the sentence which is correctly written in indirect speech.

A.  B. She said that she would go if she has time.

B.  C. She said that she would go if she had time.

C.  D. She said that she will go if she had time.

D.  A. She said that she will go if she has time.

✓

Q48 English

Read the following passage and answer the questions.

In the fable The Bird with Two Heads, a bird is born with two heads. At first, the heads argue constantly, each wanting to eat and fly differently.
This disagreement causes confusion and prevents the bird from acting effectively. Observing the chaos, the other birds warn the two-headed
bird that it must learn to cooperate or it will suffer. Gradually, the two heads realize that they can survive and thrive only if they agree on their
actions and share responsibilities. Once they start cooperating, the bird becomes strong, capable of finding food and flying safely. The story
teaches the importance of unity, cooperation, and working together despite differences. It emphasizes that conflict within oneself or between
partners can lead to failure, while harmony and coordination bring success.

According to the fable, what was the primary catalyst that forced the two heads to transition from conflict to cooperation?

A.  B. A lack of physical strength that prevented the bird from being able to fly at all.

B.  A. The realization that their survival and ability to thrive depended on shared actions.

C.  C. A direct command from the other birds who threatened to exile the two-headed bird.

D.  D. A shortage of food in their environment that made competition impossible.
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✓

Q49 English
What lesson does the story convey about disagreement?

A.  A. Arguments make you stronger.

B.  D. Ignoring others is best.

C.  B. Cooperation is necessary for success.

D.  C. Strength is only physical.

✓

Q50 English
In this context, what does “cooperate” most nearly mean?

A.  D. Compete against each other.

B.  C. Work together for a common goal.

C.  B. Ignore problems.

D.  A. Act independently.

✓

Q51 English
Which best describes the tone of the passage?

A.  D. Serious and instructive

B.  C. Playful and humorous

C.  A. Sad and mournful

D.  B. Angry and critical

✓

Q52 English
Which option best sumarizes the passage?

A.  A. A two-headed bird fights and loses to other birds.

B.  B. A bird is born with one head and learns to share food.

C.  C. Birds avoid the two-headed bird entirely.

D.  D. A two-headed bird learns to cooperate and becomes successful.

✓

Q53 English
Choose the correct form of tense for the sentence.

Every spring, the endangered turtles ______ their eggs along this protected stretch of coastline.

A.  D. were laying

B.  B. will lay

C.  C. lay

D.  A. have laid
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✓

Q54 English
Choose the correct antonym of the underlined word.

The organisation adopted a stringent policy to regulate access to sensitive user data.

A.  A. unethical

B.  D. accountable

C.  B. lenient

D.  C. firm

✓

Q55 English
In the given sentence, four words are marked bold. Choose the word which is incorrectly spelt.

Her persistance and commitment were admired by everyone at the ceremony.

A.  C. persistance

B.  A. commitment

C.  D. admired

D.  B. ceremony

✓

Q56 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.
A.she informed us that the
B.the weather conditions did not
C.ceremony would be postponed if
D.improve by tomorrow afternoon

A.  A. ACBD

B.  C. BDCA

C.  B. CBAD

D.  D. DABC

✓

Q57 English
A statement is divided into different segments. The first segment is fixed. Rearrange the other segments to form a coherent statement.

Fixed: The growing popularity of air fryers among health-conscious consumers

P: is largely due to their ability
Q: while still maintaining taste and texture
R: to cook food with minimal oil
S: in modern kitchens

A.  B. P R Q S

B.  A. S P R Q

C.  D. Q R P S

D.  C. R S P Q
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✓

Q58 English
Choose the correct option to complete the sentence.

She suggested that he ______ more careful while handling sensitive information.

A.  C. is

B.  A. was

C.  B. be

D.  D. has been

✓

Q59 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

My cousin, who lives in Nagpur, works for a group to help _____ elderly.

A.  D. a

B.  A. an

C.  C. the

D.  B. No article required

✓

Q60 English
Select the most appropriate option to fill in the blank.

Despite warnings about the water level, he insisted on swimming _______ the river, determined to complete his endurance challenge without
any assistance.

A.  B. into

B.  A. within

C.  D. across

D.  C. in
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Digital learning has become an essential part of modern education.

A.  A. ଡି ଜି ଟାଲ ଶି କ୍ଷଣ ଆଧୁ ନି କ ଶି କ୍ଷାର ଏକ ପ୍ର ମୁ ଖ ଅଂଶ ଅଟେ।

B.  C. ଡି ଜି ଟାଲ ଶି କ୍ଷା ଆଧୁ ନି କ ଶି କ୍ଷାର ଗୁ ରୁ ତ୍ୱ ଅଂଶ ହୋଇଯାଇଛି ।

C.  B. ଡି ଜି ଟାଲ ଶି କ୍ଷା ଆଧୁ ନି କ ଶି କ୍ଷା ଅଂଶ ହୋଇଯାଇଛି ।

D.  D. ଡି ଜି ଟାଲ ଶି କ୍ଷା ଆଧୁ ନି କ ଶି କ୍ଷାର ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଂଶ ହୋଇଗଲା।

✓

Q62 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଲୋଚନ

A.  B. ନାସା

B.  A. ମନ

C.  D. ହସ୍ତ

D.  C. ନୟନ

✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୋ ବାପା ରୁ ଣ ନେଇ ଆମ ପାଇଁ  ଘର କରି ଛନ୍ତି  ।

A.  B. My father has built a house for us by taking loan.

B.  A. My father is making a house for us on credit.

C.  D. My father was making a house for us .

D.  C. My father will build a house for us on credit.

✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୋ ଭଉଣୀ ର ବାହାଘର ପାଇଁ  ଆମେ ବହୁ ତ ବ୍ୟସ୍ତ ଅଛୁ  ।

A.  D. We were very busy for my sister's wedding.

B.  B. We had been busy for my sister's wedding.

C.  C. We are very busy for my sister's wedding.

D.  A. We will be very busy for wedding.
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✓

Q65 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

କାଳି ଜାଈ ହେଉଛନ୍ତି  ଓଡ଼ି ଶାର ଅଗଣି ତ ଲୋକଙ୍କ ପୂ ଜ୍ୟ ଦେବୀ | ବି ଶେଷକରି  ଏସି ଆର ସର୍ବ ବୃ ହତ ଲୁ ଣି ଆ ଜଳ ହ୍ର ଦ ଚି ଲି କା ହ୍ର ଦ ପାଖରେ ବସବାସ କରୁ ଥି ବା ଲୋକ ମାନଙ୍କ ପାଇଁ  ସେ ହେଉଛନ୍ତି
ଅଗ୍ର ପୂ ଜ୍ୟ । ହ୍ର ଦର ଏକ ଛୋଟ ଦ୍ୱୀପରେ ଅବସ୍ଥି ତ ପ୍ର ସି ଦ୍ଧ କାଲି ଜାଈ ମନ୍ଦି ରକୁ  ପ୍ର ତି ବର୍ଷ  ହଜାର ହଜାର ଭକ୍ତଙ୍କ ସମାଗମ ହୋଇଥାଏ । ମନ୍ଦି ରଟି  କେବଳ ପୂ ଜାସ୍ଥଳ ନୁ ହେଁ  ବରଂ ବି ଶ୍ୱାସ, ଲୋକକଥା
ଏବଂ ଓଡ଼ି ଶାର ଗଭୀର ସାଂସ୍କୃତି କ ଐତି ହ୍ୟର ପ୍ର ତୀକ ମଧ୍ୟ ।

ସ୍ଥାନୀୟ କି ମ୍ବଦନ୍ତୀ ଅନୁ ସାରେ, କାଳୀଜାଈ ଥି ଲେ ଜାଇ ନାମକ ଜଣେ ଯୁ ବତୀ, ଯି ଏ ବି ବାହ ପରେ ଡଙ୍ଗାରେ ତାଙ୍କ ସ୍ୱାମୀଙ୍କ ଗାଁ କୁ  ଯାତ୍ରା  କରୁ ଥି ବା ବେଳେ ଦୁ ର୍ଭା ଗ୍ୟବଶତଃ, ଡଙ୍ଗାଟି  ଚି ଲି କା ପାର ହେବା
ସମୟରେ ଏକ ଭୟଙ୍କର ଝଡ଼ ଉଠି ଲା । ଡଙ୍ଗାଟି  ଅଶାନ୍ତ ପାଣି ରେ ଓଲଟି  ପଡ଼ି ଲା ଏବଂ ଜାଇ ଦୁଃ ଖଦ ଭାବରେ ବୁ ଡ଼ି ଗଲା । ବି ଶ୍ୱାସ କରାଯାଏ ଯେ ସେ ଜାଇ ନାମକ ଯୁ ବତୀ ଦେବୀ ଭାବରେ ପୁ ନର୍ବା ର
ଆବି ର୍ଭା ବ ହେଲେ ଏବଂ କାଳୀଜାଈ ଭାବରେ ପୂ ଜା ପାଇ ପ୍ର ସି ଦ୍ଧି  ଲାଭ କଲେ । ସେବେଠାରୁ , ଏହି  ଦ୍ୱୀପକୁ  ଏକ ପବି ତ୍ର ସ୍ଥଳୀ ଭାବରେ ବି ବେଚନା କରାଯାଏ,| ବି ଶେଷକରି  ମତ୍ସ୍ୟଜୀବୀ ଏବଂ
ନାବି କମାନେ ଚି ଲି କା ଯାତ୍ରା  ଆରମ୍ଭ କରି ବା ପୂ ର୍ବ ରୁ  ସୁ ରକ୍ଷା ଏବଂ ସମୃ ଦ୍ଧି  ପାଇଁ  ତାଙ୍କ ଆଶୀର୍ବା ଦ ଲୋଡ଼ି  ପ୍ରା ର୍ଥ ନା କରନ୍ତି ।

ପ୍ର ତି ବର୍ଷ , ମକର ସଂକ୍ରା ନ୍ତି  ସମୟରେ, ମନ୍ଦି ରରେ ଏକ ମହାମେଳା ଅନୁ ଷ୍ଠି ତ ହୁ ଏ | ଏହି  ଅବସରରେ ଓଡ଼ି ଶାର ବି ଭି ନ୍ନ ସ୍ଥାନରୁ  ଶ୍ର ଦ୍ଧାଳୁ  ଆସି  ପୂ ଜା ଅର୍ଚ୍ଚ ନା କରି ଥାନ୍ତି  । ତୀର୍ଥ ଯାତ୍ରୀ ମାନେ ଏହି  ମନ୍ଦି ରକୁ
ପରି ଦର୍ଶ ନ କରନ୍ତି , ପ୍ରା ର୍ଥ ନା କରନ୍ତି  ଏବଂ ସାଂସ୍କୃତି କ ପରମ୍ପରାରେ ଅଂଶଗ୍ର ହଣ କରନ୍ତି । ଲୋକଗୀତ, ନୃ ତ୍ୟ ଏବଂ ସ୍ଥାନୀୟ ହସ୍ତଶି ଳ୍ପ ଷ୍ଟଲ ସହି ତ ପରି ବେଶ ଉଜ୍ଜ୍ୱଳ ହେବା ସହ ଚତୁଃ ପାର୍ଶ୍ଵ  ହର୍ଷ  ଓ ଆନନ୍ଦ
ରେ ଭରି  ଯାଏ । ଏହି  ଉତ୍ସବ ଓଡ଼ି ଶାର ସମୃ ଦ୍ଧ ପରମ୍ପରା ତଥା ମଣି ଷ ଏବଂ ପ୍ର କୃ ତି  ମଧ୍ୟରେ ସୁ ସଜ୍ଜି ତ ସମ୍ପର୍କ କୁ  ଉଜାଗର କରି ଥାଏ। ସମୟକ୍ର ମେ କାଳୀଜାଈ ଓଡି ଶାର ଏକ ପ୍ର ମୁ ଖ ପର୍ଯ୍ୟ ଟନ ସ୍ଥଳୀ
ଭାବେ ଖ୍ୟାତି  ଲାଭ କରି ଛି  |

କାଳୀଜାଈଙ୍କ କାହାଣୀ ବି ଶ୍ୱାସ, ତ୍ୟାଗ ଏବଂ ଭକ୍ତି ର ବି ଷୟବସ୍ତୁକୁ  ପ୍ର ତି ଫଳି ତ କରେ। ଏହା ସମୁ ଦ୍ର  ସହି ତ ଲୋକଙ୍କ ଗଭୀର ଭାବପ୍ର ବଣ ସମ୍ପର୍କ  ଏବଂ ଦି ବ୍ୟ ସୁ ରକ୍ଷାରେ ସେମାନଙ୍କର ବି ଶ୍ୱାସକୁ  ମଧ୍ୟ
ପ୍ର ତି ନି ଧି ତ୍ୱ କରେ। ବର୍ତ୍ତ ମାନ , କାଳି ଜାଈ ମନ୍ଦି ର ଓଡ଼ି ଶାର କି ମ୍ବଦନ୍ତୀ ଏବଂ ସାଂସ୍କୃତି କ ସ୍ମୃତି ର ସ୍ଥାୟୀ ଶକ୍ତି ର ସ୍ମରଣକାରୀ ଭାବରେ ଦଣ୍ଡାୟମାନ ହୋଇଛି ।

କାଳି ଜାଈ ମନ୍ଦି ର କେଉଁ ଠାରେ ଅବସ୍ଥି ତ?

A.  C. କୋଣାର୍କ

B.  D. ଚି ଲି କା ହ୍ର ଦ

C.  A. ପୁ ରୀ ବେଳାଭୂ ମି

D.  B. ହୀରାକୁ ଦ ବନ୍ଧ

✓

Q66 Odia
କି ମ୍ବଦନ୍ତୀ ଅନୁ ସାରେ ଚି ଲି କା ପାର ହେବା ସମୟରେ ଜାଇଙ୍କ ସହି ତ କ’ଣ ଘଟି ଥି ଲା?

A.  D. ସେ ରାଣୀ ହୋଇଗଲେ

B.  B. ଝଡ଼ ଯୋଗୁଁ  ବୁ ଡ଼ି ଗଲେ

C.  C. ସେ ବି ଦେଶ ଚାଲି ଗଲେ

D.  A. ସେ ଜଣେ ସନ୍ଥ ହୋଇଗଲେ

✓

Q67 Odia
କାଳୀଜାଈଙ୍କୁ  ମୁ ଖ୍ୟତଃ କେଉଁ  ମାନେ ପୂ ଜା କରନ୍ତି  ?

A.  D. କୃ ଷକ

B.  C. ମତ୍ସ୍ୟଜୀବୀ ଏବଂ ନାବି କ

C.  A. ସୈ ନି କ

D.  B. ଶି କ୍ଷକ

✓

Q68 Odia
ମନ୍ଦି ରରେ ମୁ ଖ୍ୟ ପର୍ବ  କେବେ ପାଳନ କରାଯାଏ?

A.  B. ରଥଯାତ୍ରା

B.  D. ଦୁ ର୍ଗା  ପୂ ଜା

C.  C. ମକର ସଂକ୍ରା ନ୍ତି

D.  A. ଦୀପାବଳି

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q69 Odia
ଉପରୋକ୍ତ ଅଂଶରେ "ପୂ ଜ୍ୟ" ର ଅର୍ଥ  କଣ ?

A.  C. ଅଣଦେଖା

B.  B. ଅତ୍ୟନ୍ତ ସମ୍ମାନି ତ

C.  A. ପ୍ର ତି ସ୍ଥାପି ତ

D.  D. ପ୍ର ଶ୍ନ  କରାଯାଇଛି

✓

Q70 Odia
‘ହାତ ଅଳସେ ନି ଶ ବଙ୍କା’ ହି ତୋପଦେଶଟି ର ଅର୍ଥ ଲେଖ ।

A.  A. ବୃ ଥା ପରି ଶ୍ର ମ

B.  C. ଅଳସୁ ଆ ଦୁଃ ଖ ପାଏ

C.  B. ଅତି ସାମାନ୍ୟ ମଣି ଷ

D.  D. ନି ଜେ ସମର୍ଥ ହେବା

✓

Q71 Odia
ଜେଜେ ବୋଝେ ପରି ବା ନେଇ ହାଟକୁ  ଗଲେ । ଉକ୍ତ ବାକ୍ୟରେ ବି ଶେଷଣ ପଦଟି  ଚି ହ୍ନଟ କର ।

A.  B. ଜେଜେ

B.  D. ପରି ବା

C.  A. ବୋଝେ

D.  C. ହାଟ

✓

Q72 Odia
ବ୍ୟକ୍ତି  ଅପେକ୍ଷା ଦେଶ ବଡ଼ । ଉକ୍ତ ବାକ୍ୟରେ ଅବ୍ୟୟ ପଦଟି  ଚି ହ୍ନଟ କର ।

A.  B. ବ୍ୟକ୍ତି

B.  C. ଅପେକ୍ଷା

C.  D. ଦେଶ

D.  A. ବଡ଼

✓

Q73 Odia
ଜମି ଦାର ଜଣେ 'ଦାତା' ଭାବେ ପରି ଚି ତ ଥି ଲେ, ମାତ୍ର  ତାଙ୍କ ପୁ ଅ ଜଣେ ________ ସାଜି ଲା।
(ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଶବ୍ଦ ମଧ୍ୟରୁ  ସଠି କ ଶବ୍ଦ ବ୍ୟବହାର କରି  ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର)

A.  C. ଅତ୍ୟାଚାରୀ

B.  D. ଭି କାରୀ

C.  A. କୃ ପଣ

D.  B. ନେତା
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✓

Q74 Odia
ଯେଉଁ  ବି ଶେଷଣ ପଦ ବି ଶେଷ୍ୟ ପଦର ସଂଖ୍ୟା ସୂ ଚାଏ, ତାକୁ  କ'ଣ କୁ ହାଯାଏ ?

A.  A. ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  D. ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

C.  B. ପରି ମାଣବାଚକ ବି ଶେଷଣ

D.  C. ସୂ ଚନାବାଚକ ବି ଶେଷଣ

✓

Q75 Odia
'ଉଜ୍ଜ୍ୱଳ' ଶବ୍ଦର ଶୁ ଦ୍ଧ ବନାନଟି କୁ  ଚି ହ୍ନଟ କର ।

A.  B. ଉଜଳ

B.  A. ଉଜ୍ଜଳ

C.  C. ଉଜ୍ଜ୍ୱଳ

D.  D. ଉଜ୍ଜଳ୍ୱ

Computer

✓

Q76 Computer
Which of the following components performs arithmetic and
logical operations inside the CPU?

A.  C. Memory Unit

B.  D. Control Unit

C.  A. Arithmetic Logic Unit (ALU)

D.  B. Input Unit

✓

Q77 Computer
Which command in Microsoft Word 2021 creates a new blank
document ready for entering text?

A.  A. File → New → Blank document

B.  C. File → Open

C.  B. Insert → Object

D.  D. View → New Window

✓

Q78 Computer
Which is a good approach when sending a large file as an
attachment?

A.  B. Send multiple copies of the same file

B.  D. Use cloud storage links or Compress (zip) the file

C.  C. Attach each page as a separate file

D.  A. Ignore file size limits

✓

Q79 Computer
In MS Word, choose the view that is most highly recommended for
creating and managing headings and subheadings in structured
documents.

A.  D. Draft View

B.  A. Print layout

C.  B. Outline View

D.  C. Web Layout

✓

Q80 Computer

Among the following, which is an output
device?

A.  C. Trackball

B.  B. Joystick

C.  A. Digital Camera

D.  D. Plotter

✓

Q81 Computer
MS ପାୱାରପଏଣ୍ଟରେ ସ୍ଲା ଇଡ ଟ୍ରା ଞ୍ଜି ସନ କନଫି ଗର କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ
କେଉଁ ଟି  ଏକ ଅପସନ ନୁ ହେଁ ?

A.  C. ଫେଡ

B.  A. ପୁ ଶ

C.  D. ୱାଇପ

D.  B. ଫ୍ଲା ଏ ଇନ
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✓

Q82 Computer
ଏକ କମ୍ପ୍ୟୁ ଟର ବୁ ଟ୍  ହେବାରେ ବି ଫଳ ହୁ ଏ କାରଣ ଏହାର ଫାର୍ମ ୱେର୍  ଇନଷ୍ଟ୍ରକସନ ଖରାପ
ହୋଇଯାଇଛି  । କେଉଁ  କମ୍ପୋନେଟ ସବୁ ଠାରୁ  ଅଧି କ ପ୍ର ଭାବି ତ ହେବାର ସମ୍ଭାବନା ଅଛି ?

A.  D. RAM

B.  B. ROM

C.  A. CPU

D.  C. PCB

✓

Q83 Computer
Which of the following is an example of application software?

A.  B. BIOS

B.  A. Windows Operating System

C.  D. Microsoft Word

D.  C. Device Driver

✓

Q84 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଟେକ୍ସଟ ଫର୍ମା ଟି ଙ୍ଗର ପାର୍ଟ  ନୁ ହେଁ ?

A.  C. ଫଣ୍ଟ ସାଇଜ୍

B.  B. ଫଣ୍ଟ କଲର

C.  A. ଫଣ୍ଟ ଷ୍ଟାଇଲ (ବୋଲ୍ଡ , ଇଟାଲି କ)

D.  D. ପେଜ ଓରି ଏଣ୍ଟେସନ

✓

Q85 Computer
What does the cell address 'B2' refer to in a spreadsheet application
such as Microsoft Excel?

A.  B. Column B, Row 2

B.  C. Row B, Column 2

C.  D. Sheet B, Cell 2

D.  A. Workbook 2, Cell B

✓

Q86 Computer
A website is a/an ___________________________.

A.  D. physical server

B.  A. email address

C.  C. collection of web pages

D.  B. programming language

✓

Q87 Computer
ଆପଣ ବି ଦ୍ୟମାନ MS ପାୱାରପଏଣ୍ଟ ପ୍ରେ ଜେଣ୍ଟେସନରେ ଏକ ଟେମ୍ପଲେଟ ଆପ୍ଲା ଏ କରି ବା
ସମୟରେ କ'ଣ ହୁ ଏ?

A.  D. ଏହା ସମସ୍ତ ସ୍ଲା ଇଡ ଏବଂ କଣ୍ଟେଣ୍ଟକୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  ଭାବରେ ପ୍ର ତି ସ୍ଥାପି ତ କରେ ।

B.  B. ଏହା ଟେକ୍ସଟ ଫର୍ମା ଟିଂ କୁ  ପ୍ର ଭାବି ତ ନକରି  କେବଳ ବ୍ୟାକଗ୍ରା ଉଣ୍ଡ ପରି ବର୍ତ୍ତ ନ
କରେ ।

C.  A. ଏହା ବି ଦ୍ୟମାନ ସ୍ଲା ଇଡ କଣ୍ଟେଣ୍ଟକୁ  ବଜାୟ ରଖି  ଏକ ନୂ ଆ ଡି ଜାଇନ ଆପ୍ଲା ଏ
କରେ ।

D.  C. ଏହା ପାୱାରପଏଣ୍ଟକୁ  କେବଳ ରି ଡ଼ ଓନଲି  (read-only) ଫର୍ମା ଟରେ ରୂ ପାନ୍ତର
କରେ ।

✓

Q88 Computer
What does the function =IF(A1>45, "Pass", "Fail") do?

A.  C. Always shows "Pass"

B.  D. Shows "Fail" if A1 is less than or equal to 45

C.  A. Adds A1 and 45

D.  B. Shows error

✓

Q89 Computer
In MS-Excel 2010, if excel workbook is saved in .csv format, what
is/are lost in the file?

A.  C. Cell values

B.  B. Basic formulas

C.  D. Formatting, charts and multiple sheets

D.  A. Text

✓

Q90 Computer
MS-ପାୱାରପଏଣ୍ଟରେ, ଏକ ବଡ଼ ଅବଧି  ମୂ ଲ୍ୟ (larger duration value) ସେଟ କରି ବା
ଦ୍ୱାରା ଏକ ସ୍ଲା ଇଡ ଟ୍ରା ଞ୍ଜି ସନ କ'ଣ କରି ଥାଏ?

A.  C. ଏହାକୁ  ଫାଷ୍ଟର କରି ଥାଏ

B.  B. ଏହାକୁ  ସ୍ଲୋ  କରି ଥାଏ

C.  A. ଟ୍ରା ଞ୍ଜି ସନ ଇଫେକ୍ଟକୁ  ଡି ଜେବୁ ଲ (disables) କରି ଥାଏ

D.  D. ଫେଡ୍ ‌ ଓନଲୀ (fade only) କୁ  ବଦଳି  ଯାଏ
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Reasoning

✓

Q91 Reasoning
Five people are sitting in a circle (Ram, Sham, Vaibhav, Arjun and
Kapil) facing away from the centre. Ram is sitting second to the left
of Sham. Vaibhav is not an immediate neighbour of Ram. Arjun is
sitting to the immediate right of Vaibhav.

What is the position of Kapil with respect to Vaibhav?

A.  B. Second to the left

B.  A. Immediate right

C.  D. Immediate left

D.  C. Second to the right

✓

Q92 Reasoning
In a certain code language,
‘A + B’ means ‘A is the sister of B’;
‘A * B’ means ‘A is the husband of B’;
‘A − B’ means ‘A is the mother of B’ and
‘A & B’ means ‘A is the brother of B’.

If ‘V + S * K − R & A’, how is S related to A?2439

A.  B. Mother

B.  A. Father

C.  C. Sister

D.  D. Brother

✓

Q93 Reasoning
LION is related to VSYX in a certain way based on the English
alphabetical order. In the same way, ZWCB is related to JGML. To
which of the following options is DAGF related to, following the
same logic?

A.  C. NKQP

B.  D. NKOP

C.  B. NMKO

D.  A. NHYT

✓

Q94 Reasoning
Seven boxes, I, J, K, L,W, X and Y, are kept one over the other but not
necessarily in the same order. Only three boxes are kept above J.
Only one box is kept between Y and J. Only three boxes are kept
between Y and I. I is kept at some place above J. K is kept
immediately below I. X is kept at one of the places above L. W is not
kept immediately above or below Y. Which box is kept at the
lowermost position?

A.  B. I

B.  C. J

C.  D. L

D.  A. X

✓

Q95 Reasoning
ରମଣ ବି ନ୍ଦୁ  A ରୁ  ଆରମ୍ଭ କରି  ପୂ ର୍ବ  ଦି ଗକୁ  62 km ଗାଡି  ଚଲାନ୍ତି  । ତା' ପରେ ସେ ବାମ
ମୋଡ଼ ନେଇ 56 km ଗାଡି  ଚଲାନ୍ତି  ସେ ପୁ ନର୍ବା ର ବାମ ମୋଡ଼ ନି ଅନ୍ତି  ଏବଂ 64 km ଗାଡି
ଚଲାନ୍ତି  । ଏହା ପରେ ସେ ବାମ ମୋଡ଼ ନେଇ 65 km ଗାଡି  ଚଲାନ୍ତି  । ସେ ଶେଷ ବାମ ମୋଡ଼
ନି ଅନ୍ତି , 2 km ଗାଡି  ଚଲାନ୍ତି  ଏବଂ ବି ନ୍ଦୁ  P ରେ ଅଟକି ଯାଆନ୍ତି  । ବି ନ୍ଦୁ  A ରେ ପୁ ନର୍ବା ର ପହଞ୍ଚି ବା
ପାଇଁ  ସେ କେତେ ଦୂ ର (ସର୍ବ ନି ମ୍ନ  ଦୂ ରତା) ଏବଂ କେଉଁ  ଦି ଗକୁ  ଗାଡି  ଚଲାଇବା ଉଚି ତ? (ଯଦି
ଦି ଆଯାଇ ନାହିଁ ତେବେ ସମସ୍ତ ମୋଡ କେବଳ 90° ଅଟେ ।)

A.  C. 7 km ଉତ୍ତର ଦି ଗକୁ

B.  A. 8 km ଉତ୍ତର ଦି ଗକୁ

C.  D. 9 km ଉତ୍ତର ଦି ଗକୁ

D.  B. 10 km ଦକ୍ଷି ଣ ଦି ଗକୁ

✓

Q96 Reasoning
ଯଦି  ସଂଖ୍ୟା 132465 ର ପ୍ର ତ୍ୟେକ ଅଯୁ ଗ୍ମ  ଅଙ୍କରେ 1 ଯୋଗ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ ଯୁ ଗ୍ମ
ଅଙ୍କରୁ  2 ବି ୟୋଗ କରାଯାଏ, ତେବେ ଏହି ପରି  ଗଠି ତ ନୂ ତନ ସଂଖ୍ୟାରେ କେତୋଟି  ଅଙ୍କ
ଏକାଧି କ ଥର ଦେଖି ବାକୁ  ମି ଳି ବ?

A.  C. କି ଛି  ନାହିଁ

B.  B. ଏକ

C.  A. ଦୁ ଇ

D.  D. ତି ନି

✓

Q97 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?

NPN OOP PNR ? RLV

A.  D. MJI

B.  B. FRT

C.  A. QMT

D.  C. KJU

✓

Q98 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ଅକ୍ଷର-ପୁ ଞ୍ଜ ଯୋଡି  ମଧ୍ୟରୁ
ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ଏବଂ ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ ଟି
ସେହି  ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ?
ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟତା ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ ର ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର-ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ  ।

A.  C. AW−RQ

B.  D. UQ−MI

C.  B. HD−ZV

D.  A. RN−JF
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✓

Q99 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: Some Mountains are Hills. Some Hills are Valleys.
Conclusion I: Some Mountains are Valleys.
Conclusion II: No Mountains are Valleys.357

A.  B. Only conclusion (I) follows

B.  A. Only conclusion (II) follows

C.  C. Neither conclusion (I) nor (II) follows

D.  D. Both conclusions (I) and (II) follow

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । (ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ
କରାଯି ବ । ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକ ଅଙ୍କ ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ ।)

(ବାମ) 5 7 9 4 2 9 3 2 6 1 3 6 7 1 5 7 9 4 2 6 7 1 2 9 3 5 7 1 (ଡାହାଣ)

ଏପରି  କେତୋଟି  ଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି  ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ପୂ ର୍ଣ୍ଣ ବର୍ଗ  ଏବଂ ଠି କ
ପରେ ଏକ ଅଯୁ ଗ୍ମ  ଅଙ୍କ ମଧ୍ୟ ଅଛି ? (ଟି ପ୍ପଣୀ: 1 ମଧ୍ୟ ଏକ ପୂ ର୍ଣ୍ଣ ବର୍ଗ  ଅଟେ ।)

A.  D. ତି ନି ରୁ  ଅଧି କ

B.  A. ଏକ

C.  B. ଦୁ ଇ

D.  C. ତି ନି
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